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Chapter 1 Software installation and startup

1. Software installation
Step 1 : Insert the software installation CD into the CD-ROM drive.
Step 2 : Open the drive icon, double-click the Setup.exe file in the root directory to
start the installation,
|l A # B
vredistx85  Windowshstall  InspectiOmsi  setup.exe

Step 3 : Click the "Next" button step-by-step.
Step 4 : After the main program is installed, the dongle driver will be installed au

-tomatically,

Info @

| 3 | Pls. insert USE key.if please insert USB key, then click 'OK", If you

e a new hardware install dialeg, please click 'Cancel’




Step 5 : Click the “OK" button to complete the installation,
Step 6 : Click the “Close” button to exit the installation,
Step 7 : According to your needs, you may also need to install the following device
drivers,
@ Motion controller (card)
@ light source
® Video capture card (camera)
Install the above device drivers according to its instructions or under the guidance
of the equipment service personnel.



2. Software startup

After the software is installed successfully, insert the USB key into the computer
USB interface, open the power switch of the image measuring instrument, dou-
ble-click the software icon on the desktop, the software will start. When the software
pop up the "Go Home" dialog box as shown below. Be sure to confirm there are no
obstacles on the worktable of the machine or around it, and then click the "Begin”
button to find the Home Position of the image measuring instrument. The software
will automatically enter the main interface after it has found the Home Position. (Note:
Here the Home Position refers to the mechanical coordinate origin of the image
measuring instrument. You should find the Home Position when the software

popsup “Go Home"” dialog box.)
Go Home @

Go Home?

| Bean | | Skip




Chapter 2 The Software interface
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Main menu : Store the main functions and not commonly used functions of the
software. In order to keep the interface clean, many not commonly used functions can
be found in the main menu.

Image area : Area for displaying the image and measuring operation.

Graphics area : The results of the measurements are displayed in the form of geo-
metric graphics, 2D and 3D graphics are supported in this area, it is also known as
"CAD area".

Graphics toolbar : Mark dimensions on the geometric graphics and observe the
geometry.

Coordinate display area : Display the XYZ triaxial scale coordinate data.

Motion control panel : Control the XYZ triaxial movement. (Note: The manual version
of this software without this panel)

Light source adjustment panel : Adjust the brightness of the contour light, surface
light, coaxial light and open the laser indicator.

Comparative measurement toolbar : Measure the image with comparative meas-

urement method.



User program toolbar : The stopping, running, and setting operations of the user
program are carried out in this toolbar,

Measurement element list area : Display the extracted geometric elements, such as
points, lines, circles, and so on.

Result display area : Display the measurement results of each selected element, such
as "size", "tolerance", etc.

Command display area: display the name of the element and the coordinate system.
Measurement element Toolbar : Select the type of element to be measured, such as
point, line, circle, arc, etc.

Measurement method toolbar :Select the measurement method for each element to
be measured.

Construction toolbar : Construct the composite elements with the existing elements.
Coordinate toolbar : Create and save coordinate systems,

Export toolbar : Export the resulting data.

Status Bar : Display the status of the program, as well as display some tips and other

information.



In addition, the map area and the scan area are in the same position as the graphics
area



Chapter 3 light adjustment and lens focusing

1. Light adjustment

The software supports a variety of lighting modes. The corresponding adjust op-
eration takes effect only when the instrument is equipped with a corresponding light
source and the light source must support the corresponding lighting mode. The light

source control panel is as follows:

Laser indicator Checkbox

xS

Rotate the light section
106

Contour light area (=] Brightness adjustment scroll bar
Surface light area
|OFF |

Lighting mode
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The following contents describes the brightness adjustment methods of the
contour light, coaxial light, and surface light. The surface light supports the “5-ring
8-section” lighting mode.

(1) Adjusting the contour light :
->Select the full lighting mode
~>Click inside the small circle
->Drag the brightness adjustment scroll bar

E | l:l

106

(2) Adjusting the surface light all bright :
> Select the full lighting mode

> Click the ring area

>Drag the brightness adjustment scroll bar 0O0HED @




(3) Adjusting coaxial light :

->Select coaxial lighting mode
->Drag the brightness adjustment scroll bar

(4) Adjusting the brightness of a ring of the

surface light :
—>Select the ring lighting mode

~>Click on a ring
—>Drag the brightness adjustment scroll bar

10
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(5) Adjusting Some Sections of the surface light :
->Select the section lighting mode
->Click some sections
->Drag the brightness adjustment scroll bar
(Note: Click the left or right arrows to turn the
selected sections clockwise or counterclockwise.)

(6) Adjust some segments of the surface light :
->Select the section lighting mode
->Click some segments
- Drag the brightness adjustment scroll bar
(Note: Click the left or right arrows to turn the

selected segments clockwise or counterclockwise.)
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2. Lens focusing

(1) Manual focus

The manual focus is to lift the Z-axis manually and determine whether the image is
clearest by observation of human eyes.

(2) auto-focus ( The auto-focus function is only used for CNC image measuring
instruments )

The auto-focus function refers to automatically finding the clearest position of the
image by the software. Steps are as follows:

12



Step 1: Move the local area of the measured workpiece to the software image area.
When measuring the surface of the workpiece, you need to open the surface
light, if you only want to measure the contour feature of the workpiece, you do
not have to turn on the surface light, then move the Z-axis in to roughly focus

the image clearly.

Ileylm [ | 1 [Tl
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Step2: Click the auto focus button , Then there will be a red focusing square in the
image area. Move a section contour or a surface feature into the focusing
square. (You can also hold down the left mouse button in the focusing square
and drag the mouse to move the square to the location you want to focus on,
or place the mouse cursor on the edge of the square and drag the mouse to
change the square size.)

Focusing square

Auto-focus button ‘

Bl 1

jig* |8
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Step 3: Click the left mouse button outside the focus box, the software will control the
machine automatically move the Z-axis, and eventually stay in the clearest
position.

| | | 1 [77] 4

.
il

1553
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Chapter 4 Motion Control

The motion control is only used for the CNC image measuring instrument, the manual
image measuring instrument can skip this chapter.

1. Motion control panel.

The movement of the machine worktable can be controlled by the motion control

panel. As shown below:

XY-axis movement is con-

trolled by these 4 arrows

Click on 4 blank areas of the
diagonal to control the oblique —

direction movement

15,03 — |
XY-axis movement speed/

adjustment scroll bar

_Flioe | 0.0010

The jog checkbox /

mm

Z axis movement is controlled
13.03_L-

\ﬂ ‘i}/ by these 2 arrows

~ Z—eTxis movement speed
adjustment scroll bar

SetﬁngL .
~ [riaxial movement speed

setting button
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2. Using the image area to control the movement
Method 1: Hold down the middle mouse button at any position in the image area,
and drag the mouse in any direction. You can move the worktable in the

direction of the arrow.
Method 2: Right-click at any pixel point of the image area, select the "Move to here”

menu option, and you can move this point to the center of the image area.

Move to here

Move Here(Laser)
/  BeginFocus

Stop Focus

Manual Light

@zl =l 1 |l

Az =l 1 ol

Pixel Calibration 3

e e e e Save Image

bright---> dark

dark---> bright
bright <> dark

Display Cursor Position

Show data

Method 1 Method 2
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3. Moving to a specified coordinate point
Step 1: Select the"Image—> Move to ..." In the main menu.
Step 2: Enter the coordinate values of a point in the popup dialog box, and then click

the "Move” button, and you can move this point to the center of the image

area. the "Relative” option represents that the the movement is relative to

the current position, a

ment is relative to the

nd the “Absolute”

machine origin.

File[F} Preset(P} CS{C} User Program(F}

Image(l} | System Settings(5] Tools(B] Help(H]

option represents that the move-

b =~

£5 =11 {010-

IMove To...
-

| =
Pixel Calibration P —

Show Cross

Cross Settings
Show Scale
Show Scale
Show Grid
Grid Settings
ZI Show Dimension
Zl Show Element
Show Element Standard Position

Show Element Tolerence Zone

Show Elementis) UnmeasurediU)
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4. Moving to the element center
Step 1: Right-click an element in the element list area or right-click an element in the

graphics area.
Step 2: Select the "Move to Element Center" menu option to move the center of this
element (such as the center of the circle, line etc.) to the center of the image

area.

Rotate

/ n U.0mm

Move to element center

Move to Center(Standard Center}
Move to center{laser)

Set Find Edge Parameter

Figure Tolerance Diagram
Re-measure

Reset z-coordinate

Start Measure Here

Insert _—

Izl =sle |1 o4

Cancel Insert
Set User Name

search

Reset store position

Edit element mask

Graphics Disp Select all

Delete

> Cancel
" LIN1 LIN1

n o LNZ LINZ
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5. Coordinate axis jog
Step 1: Select the jog checkbox and enter the jog distance in the motion control panel.
Step 2: Click the arrow of the axis that you want to move, and the machine will move

the jog distance in the direction of this axis.

20



6. The image navigation function

You can get a picture of the workpiece (especially the large size workpiece) by the
way of scanning or taking pictures, and make the pixels of the picture correspond to
the coordinate points of the actual workpiece, then you can quickly locate the position
of the workpiece by taking the picture as an image navigation, right-click at any point
on the picture in the image navigation window, and select the "move here" menu
option, the machine will automatically move this point of the workpiece image to the
center of the image area.

The image navigation function is usually used for the large-size workpieces and the
workpieces with a lot of similar features.

21



For example, the size of the following mobile phone shell is large, and there are a
lot of elements to be measured in it. For easy locating, you can make a navigation
picture of this shell.

22



(1) Making a picture with integral scanning
Step 1: Click the "Image Navigation" tab under the graphics area, switch to the image

navigation window, click the "scan workpiece" button, and then it will pop up
the "Scan Workpiece Setting" dialog box.

FilelF] Presetlf) CS[C) UserProgram(P) Image[] System Settings(s) ToolsiE) Help(H]

Scan workpiece setting e
Lefitop
X 3164 Rear |
T 5094
Righthattom
% 32,641 W|
-6.099
Ok Cancel

Graphics Display I Imags Mavigation I
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Step 2: Move the top left corner of the workpiece image to the center of the image
area. Click the "Read" button at the top of the dialog box to read the coordi-
nates of the top left corner of the navigation picture (Note: Do not close the
"Scan workpiece Settings" dialog box now).

| Scan workpiece setting @

|

| Lefttop

|

| X 3264

|

|

| iE -6.099

|

|

: - Rightbottom

| X -32.641 -Read

|

|

| iz -6.099

[

|

I

|

| o ] [ coneel |
B #Radih v = BRI |
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Step 3: Move the bottom right corner of the workpiece to the center of the image
area, and then click the "Read" button at the bottom of the dialog box to read

the coordinates of the bottom right corner of the navigation picture.

Scan workpiece setting @
Lefttop
¥ -6.099

| Rightbottom

|

I Y 6.089

|

|

|

|
b - 1161012 Y = R1.37m1 |
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Step 4: Click the "OK" button in the dialog box, and the machine will start to scan the
workpiece automatically. After the scanning is complete, you can get the

whole picture of the workpiece

Scan workpiece setting
Lefttop
X -32.641
Y: -6.099
Rightbottom
X 150.03
| 120141

el

Cancel

Move here

Move here(Laser)

Move to here(Laser Only XY)

Terminate Scan

Glaphis Diplay | Image Mavigation |

Step 5: Click the right mouse button at any point of the navigation picture, select the

"Move Here" menu option, the image area will be automatically positioned to

that point. Click the

IlSavell

button at the top of the image navingation

window to save the navigation picture.
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(2) The navigation picture calibration:
Any picture can be used as a navigation picture after it is calibated. Try to choose

the sharp points in the picture to calibrate.
Step 1: Click the "Open” button in the image navigation window to open the

picture document you want to calibrate, and then click the “Calibrate”
button.

i 0| =| [ [FF] o -]

Graphics Display | Image Mavigation [
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Step 2: Click the "“OK” button in the pop-up dialog box, move the first sharp point
on the workpiece to the intersection of the cross lines in the image area, then

double-click the corresponding point of the picture in the image navigation

window.

=

F l* Czlibration begin, please double click to select the first point.

The first sharp point double-click the corresponding point

| o= mlmlu|i|o]s -x] /

o [—"

image navigation window
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Step 3: Continue to click the “OK” button in the pop-up dialog box, move the
second sharp point on the workpiece to the intersection of the cross lines in
the image area, and then double-click the second corresponding point in the
image navigation window.

=

h Please select s=cand paint!

]| e | =] | BB || W |15 2 12 =[]

Gaghics Display | image Navigation | \

the second sharp point double-click the corresponding point
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Step 4: Click the "OK” button in the dialog box to complete the calibration.

I Calibrate success!

Note: when the position of the workpiece is been changed relative to the
worktable, you can also use the above calibration steps making the navigation

picture pixels and the actual workpiece coordinates to re-correspond.
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Chapter 5 Pixel Calibration

1. Pixel calibration instructions
(1) Definition: Pixel calibration refers to establishing the correspondence between

the pixel size of the computer display and the actual size.
(2) The necessity of pixel calibration :

@ Calibration must be performed before the first measurement, otherwise the

measurement results may be incorrect.

@ The different magnifications of the lens correspond to different pixel calibration
data, and you must perform the corresponding pixel calibration before measuring
at a certain magnification.

® Pixel calibration must be performed after the CCD camera or lens are replaced or

loosened.

31



(3) Pixel calibration type :

@ Four circles calibration The four circles calibration means that the same standard
circle is moved to the four quadrants of the cross lines in the image area for cal-
ibration.

@ One circle calibration : The one circle calibration means that a standard circle is
moved to the center of the image area for calibration.

(4) Operation method :

@ Manual calibration : When performing calibration, manually move the standard
circle and manually capture the contour of the circle image. (Usually used for the
manual image measuring instrument).

@ Automatic calibration : Automatically move the standard circle and automatically
capture the contour of the circle image. (Usually used for the CNC image meas-
uring instrument).

32



(5) Pixel calibration standard :
Please use the calibration standard provided by the supplier of the image measur-

ing instrument to calibrate, such as a glass calibration sheet.
Note: Usually the manual machine uses the manual-four-circle calibration, the

CNC machine uses the automatic-four-circle calibration, the one-circle calibration
is used for the machine that its worktableis not movable or no linear scales.

33



2. Pixel calibration steps

(1) The following describes the four circle pixel calibration method at the 0.7X
magnification. Please distinguish the difference between the manual machine
and the CNC machine.

Step 1: Select the pixel calibration type: Select the "System settings>User Prefer-
ences" in the main menu, and select the calibration type in the popup dialog
box. In general, please select the "Using four circles " option for the measuring
instrument that its XY-axis with linear scales.

(=50
File[F) Preset(P) CS{C) UserProgram(F} Imagefl} | System Settings(S) | Tools(B}) Help[H)
& Language »
ECEE —| .|P"_f""| ; _j|//‘ 18
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Output Display(s)

User Program(U}
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CAD Settings
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Safe Height... thers
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Step 2: Select the pixel calibration method: Right-click in the image area, and select

the "Pixel Calibration> Pixel Calibration Management" menu option, and then

Select “"Manual” or “Auto" calibration in the dialog box.
(Note: Please select the "Auto” item for the CNC machine, and the manual

version software is no this option.)

— Glllhum

Move to here
Maove Here(Laser]
/' Begin Focus
Stop Focus
Manual Light

Pixel Calibration

Save Image

bright---> dark
dark-—=bright

bright < > dark

Display Cursar Position
Show data

Pixel Calibration

Pixel Calibration in all Zoom Scales

Pixel Calibration Management
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Step 3: Focusing and dimmer: Adjust the zoom lens to the 0.7X magnification, select
a standard circle on the glass calibration sheet, move the circle to one quad-
rant of the image area and lift the Z-axis to focus it. (Note: In order to ensure
the accuracy of the calibration, the circle should not be too small or too
large, its image size like the following figure is better, it is recommended
to turn off the surface light, and adjust the contour light source to the
appropriate brightness, so it can enhance the contrast of the standard

circle contour, and make the image more clearly.)
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it |

b 1= N I

531k

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

36



Step 4: Right-click anywhere in the image area and select the

Calibration" in the pop-up menu.
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Step 5: Move the circle and capture the edge: Please select one of the following two
methods according to the machine is a CNC image measuring instrument or a
manual image measuring instrument.

Method 1: For the CNC image measuring instrument
When you select the “pixel calibration” menu option, the red Find-Edge
-Tool will appear automatically on the standard circle, and then double-click
the left mouse button inside the Find-Edge-Tool or press the space bar or the
Enter key on the keyboard, the software will automatically move the standard
circle image and automatically capture the edge of the standard circle image.

|
|
1 |+

1 I T

=31k
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Method 2: For the manual image measuring instrument

You need to manually move the standard circle image and manually capture the edge
of the circle image, click the left mouse button at three different points on the cir-
cumference (or hold down the left mouse button and drag the cursor), there will be a
Find-Edge-Tool appear, make the edge of the standard circle be located between the
inner and outer circles of the Find-Edge-Tool, double-click the left mouse button on
the standard circumference to complete the edge capture operation in the first
quadrant. Manually move the standard circle to to the other three quadrants to

complete the same ope @ @

ml+
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ISR ED 58

[SUSIEIINBY
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Step 6: Save the calibration data: The software will automatically pop up the save
dialog box after the capture edge operation is complete, enter the calibration
name in the dialog box, for easy identification, it is recommended to use the
current magnification of the zoom lens as the calibration name, such as 0.7X,
1.0X, 2.0X, 4.5X and so on. Enter the name and click the "“OK" button to

complete the pixel calibration.
Save @

Input Mame:  0.7X

[ oK ] | Cancel |

Step 7: Use the same steps to complete the pixel calibration at the other magnifica-
tion
(2) One circle calibration :
The one circle calibration steps are similar to the above steps. One circle calibra
tion generally selects a larger standard circle and places the circle in the center of
the image area. It is used for the image measuring instrument that its worktable is

not movable or no linear scales.
40



3. Pixel calibration management

Click the right mouse button in the image area and select the "Pixel Correc-
tion>Pixel Calibration Management" menu option to open the "Pixel Celebration
Management" window. The window list area lists the calibration data items. The green
item is the current calibration data, you can double-click any item to activate it as
current, or right click on the item and activate it in the pop-up menu, or recalibrate
and delete the item. The save button is to save all items to a folder, the read button is

to import the saved calibration data and use it.

 Slillum
i Pixel Calibration Manager - PinelCalibrini = | | ]
1= Name A B C D
Move to here A ~0.7x% -0.010015 0.000147 0.000138 0.009174
Move Here(Laser _T ~10% -0.006765 0.000097 0.000092 0.006194
/e =5 20 -0.003380 0.000047 0.000048 0.003098
I N
sto m 3 0% -0.002259 0.000034 A 158
Manual Light
Pixel Calibration 4 Pixel Calibration E Callbrate
Pixel Calibration in all Zoom Scales DE‘EtE
Save Image
Pixel Calibration Management
bright-—= dark
darko—bright
bright<-->dark
Display Cursor Position
Show data
Manual
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Chapter 6 Element measurements

Elements include the point, line, circle, arc, ellipse, rectangle, slot, ring, open curve,
closed curve and the other geometric elements.

1. Steps of element measurement

Step 1 : In the Measurement element toolbar, click a certain element button, and then
click a method button in the Measurement Method Toolbar.

Step 2 : Use the mouse to capture points or edges in the image area.

Step 3 : Select the extracted element in the "element list area" and view the element
measurement results in the "result display area".

Step 4 : Use the Export Toolbar to export the measurement result data.
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2. Element measurement method
(1) The measurement methods of a point

@ Extracting a point with the line intersection method

Step 1: Select the "Point" element button and the "Boundary" method button.

Step 2: Click the left mouse button in the image area, there will appear a line with
arrow, and make the line intersect with image contour, and double-click the
mouse on the line (you also can press the spacebar or the enter key on the

keyboard) to complete the operation.
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@ Extracting a point with mouse clicking

Step 1: Select the "Point" element button and the "mouse” method button.

Step 2: Move the cross cursor to the edge of the image in the image area. When the
color of the cross cursor changes, click the left mouse button (you can also
press the spacebar or the Enter key on the keyboard) to complete the opera-

tion.
e =
E
| /|e|F |e|olo|o|#| 8| :
A B VP g
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® Extracting the closest point to the mouse cursor

Step 1: Select the "point" element button, and the "near " method button.

Step 2: Move the mouse cursor near the edge of the image in the image area, click the
left mouse button, and a circular Find-Edge-Tool will be appeared, and then
you can extract the closest point to the mouse cursor on the edge of the circle.
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@ Extracting a point by magnifying the image
Step 1: Select the "Point" element button, and the "Zoom" method button.

Step 2: There will be a red square in the center of the image area, and popup the

zoom window at the same time, move the red square to the local area that

you want to magnify. This local area is magnified 3 times in the zoom window,

holding down the left mouse button and drag the image in order to make the

image contour intersect with small cross cursor, double-click the left mouse

button in the zoom window to complete the operation.

Zoom Window-3.0x
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® Extracting a point with the cross lines

Step 1: Select the "Point" element button, and the "Cross" method button.

Step 2: You can move the the edge of the image to the intersection of the cross lines.
When the color of the cross lines changes, double-click the left mouse button
(You also can press the spacebar or the Enter key on the keyboard) to com-
plete the operation.
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® Extracting the peak point

The peak point refers to the highest point or the lowest point in a direction,

Step 1: Select the "Point" element button, and the "Peak Point" method button.

Step 2: Click the left mouse button at two different points near the image contour,
and then drag the mouse and click the left button to determine the direction
of the Find-Edge-Tool, double-click the left mouse button in the
Find-Edge-Tool, you can extract the peak point in this direction.
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@ Extracting a point with autofocus method

This method can extract a point in the intersection of the cross lines of the image
area with autofocus method, it is usually used to measure a plane flatness or the
height between two steps.
Step 1: Select the "Focus Plane" element button and the "Boundary” method button,

there will be a red focusing square in the center of the image area.
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Step 2: Move a surface of the workpiece into the red focusing square, and then lift
the Z-axis to make the surface is roughly focused , double-click the left
mouse button to extract the first focusing point of this surface. (You can also
hold down the left mouse button in the focusing square and drag the mouse
to move the square to the position you want to focus on, or place the mouse

cursor on the edge of the square and drag the mouse to change the square
size.) Focusing square

Iilzzlm I |1 fml

| | Show elements only over torlerence

Use the same method to extract other focusing points. You can construct a
plane with all these focusing points.(Element construction see Chapter 7)
select this plane element in the element list area, You will see its flatness
value in the result display area.
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Step 3: Move the the second surface of the workpiece into the red focusing square,
and then lift the Z-axis to make the second surface is roughly focused,
double-click the left mouse button to extract the a focusing point of this

surface.
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| | Show elements only over torlerence

Use the same method to extract other focusing points. You can construct a
plane with all these focusing points.(Element construction see Chapter 7),
select this plane element in the element list area, You will see its flatness value
in the result display area.
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Step 4: To get the height value between these two plane, you can construct the
distance between them. (How to construct the distance see Chapter 7)

(2) Extracting a straight line

@ Extracting a straight line by capturing the entire edge

Step 1: Select the "Line" element button and the "Boundary" method button.

Step 2: Hold down the left mouse button and drag the cursor in the direction of the
image edge, draw a rectangular Find-Edge-Tool, double click the left mouse
button in the Find-Edge-Tool (you can also press the spacebar or the enter key
on the keyboard) to complete the operation.(Note: The aorrow of the
Find-Edge-Tool indicates the direction of scanning, The edge judgment is
based on the gray value of the pixels, the direction includes from bright to
dark, from dark to bright, and from the bright and dark at the same time, you
can click the right mouse botton outside the Find-Edge-Tool and select the
scanning direction in the pop-up menu, and you can also click the middle

mouse botton in the Find-Edge-Tool to change the scanning direction .)
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@ Extracting a straight line by capturing Multiple segments
The method of capturing multiple segments is often used to measure the line that its

image range is beyond the image area.
Step 1: Select the "Line" element button and the "Subsection” method button, and set

the number of the segments, and select the "Auto” check box.

Step 2: Hold down the left mouse button and drag the cursor in the direction of the
image edge, double click in the Find-Edge-Tool (you can also press the
spacebar or the enter key on the keyboard) to extract the first segment, and
move other segments of the measured edge into the image area and extract it
by the same method, you will be able to complete the operation.
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(3) Extracting a circle

@ Extracting a circle by capturing the entire boudary

Step 1: Select the "Circle" element button and the "Boundary" method button.

Step 2: hold the left mouse button and drag the cursor in the measured circle center
(you can also click three different points on the edge of the measured circle),
draw a ring Find-Edge-Tool, The arrow of the Find-Edge-Tool indicates the
direction of scanning, you can hold down the left mouse botton in the
Find-Edge-Tool and drag the cursor to move it, or resize it by dragging the
inside and the outside circle of the tool. Make the measured contour edge is
between the inner and outer circles of the tool, and double-click left mouse
botton in the tool (You also can press the spacebar or the enter key on the

keyboard) to complete the operation. 5
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®@ Extracting a circle by capturing Multiple segments

This method is mainly for large circles that its image size is larger than the image area.

Step 1: Select the "Circle" element button and the "Subsection” method button, and

set the number of segments, and select the "Auto" check box.

Step 2: Move one segment arc contour edge of the measured circle into the image
area, double click the left mouse botton at two different point of the arc, and
then the Find-Edge-Tool will appear, adjust the tool size and shape to fit to the
arc contour, double click in the Find-Edge-Tool (you can also press the
spacebar or enter key on the keyboard) to extact the first arc segment, move
other segments of the measured circle into the image area and extract it by the
same method, and you will be able to complete the operation.
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® Extracting a circle by the “contour” method
Step 1: Click the "Circle" element button and the "Contour " method button.
Step 2: Double click the left mouse botton in the Find-Edge-Tool to complete the

operation.
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@ Extracting a circle by capturing Multiple points

Step 1: Click the "Circle” element button and the corresponding method button of

extracting points, set at least 3 points, and select the "Auto" checkbox.

Step 2: Move the cursor to the contour of the circle to be measured in the image area.
When the color of the cursor changes, click the left mouse button (you can
also press the space bar or the Enter key on the keyboard) to complete to
extract the first point, then use the same method to extract other points.
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(4) Extracting an arc
The method of extracting an arc is similar to the circle. Please follow the above steps.

(5) Extracting an ellipse

@ Extracting an ellipse by capturing the entire boudary

Step 1: Select the "Ellipse” element button and the "Boundary” method button.

Step 2: Click the left mouse button on the two vertices of the long axis of the ellipse to
be measured, and then move the cursor in the direction of the short axis.
Double click the left mouse button when the tool is basically fitted to the
ellipse profile (You can also click the left mouse button and then press the
space bar or the Enter key on the keyboard) to complete the operation,
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@ Extracting an ellipse by capturing Multiple segments
This method is mainly used for the large ellipse that its image size is larger than the
image area.
Step 1: Click the "Ellipse" element button and the "Subsection” method button, set at
least 4 segments, and select “Auto" checkbox.
Step 2: Extract the measured ellipse according to the number of segments you have

set. You can move the outside segments into the image area to extract them.
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® Extracting an ellipse by capturing Multiple points
Step 1: Click the "Ellipse" element button and the corresponding method button of
extracting points, set at least 5 points, and select the "Auto" checkbox.
Step 2: Extract points on the contour of the ellipse according to number of the points
you have set. It is recommended that these points include the four vertices of
the ellipse. (Note: Click the left mouse button when the color of the mouse

cursor changes)
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(6) Extracting a rectangle

@ Extracting a rectangle by capturing the entire boudary

Step 1: Select the "Rectangle” element button and the "Boundary" method button

Step 2: Click the left mouse button on two vertices of any side of the measured
rectangle, and move the cursor to the opposite edge and double click the left
mouse button (you can also press the space bar or the enter key on the
keboard) to complete the operation.
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@ Extracting a rectangle by capturing Multiple segments
This method is mainly used for the large rectangle that its image size is larger than

the image area.
Step 1: Click the "Rectangle” element button and the "Subsection” method button

and set at least 4 segments. Select "Auto" checkbox.
Step 2: Move one or two sides of the measured rectangle into the image area, extract
them, then move the other sides into the image area and extract them (Note:

All sides of the rectangle must be extracted).
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® Extracting a rectangle by capturing Multiple points

Step 1.

Step 2:

Click the "Rectangle” element button and the corresponding button of
extracting points, set at least 5 points, and select the "Auto" checkbox.

Click the left mouse button on either side of the measured rectangle and
extract two points on this side, and then extract a point on each side of the
remainning sides.(Note: click the left mouse button when the color of the
mouse cursor changes)
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(7) Extracting a slot

Extracting a slot by capturing the entire boudary

Step 1: Select the "Slot" element button and the "Boundary" method button

Step 2: Click 3 points on one arc of the slot, then a slot Find-Edge-Tool will appear,
make the tool size and direction fit to the measured contour, double click
the left mouse button in the Find-Edge-Tool (You can also press the space bar
or the enter key on the keyboad) to complete the operation.
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(8) Extracting a ring

Extracting a ring by capturing the entire boudary

Step 1: Select the "Ring" element button and the "Boundary” method button.

Step 2: Click three different points on the inner circle or the outer circle of the ring
image, then the ring Find-Edge-Tool will appear, you can put the cursor on one
circle of the tool and drag the mouse to change its size, make the inner and
outer circle contour of the measured ring image is clamped between the three
circles of the tool, double click the left mouse button in the tool (You can also
press the space bar or the enter key on the keyboad) to complete the

operation.
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(9) Extracting an open curve

Step 1: Click the "Open Curve" element button and the "Contour" method button.

Step 2: Click the left mouse button and drag the cursor near the measured contour to
draw a line with arrow, make the line intersect with the measured contour,
and click the left mouse button again, put the cursor on the arrow and double
click the left mouse button to extract the first point. Extract the second point
and the third point in the same way. Enter the total number of the points to
be extracted for the open curve in the pop-up dialog box and click the OK
button to complete the operation. You can also pre-set the total extraction
points number of the open curve in the "User prefrence settings” dialog
box(See Chapter 12).(note:The first point above is the starting point of the

open curve, the second point is the direction, and the third point is the end
point)
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Note: The above method can also be used to extract the open curve that its image
size is larger than the image area. The open curve measurement is the quickest
and most effective method to measure the length of an irregular curve. You can
obtain the length value of the curve in the result display area.
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(10) Extracting a closed curve

Step 1: Click the "Close Curve" element button and the "Contour" method button.

Step2: Use the above method of extracting the open curve to extract the starting
point and the direction point of the closed curve. And you will obtain the

closed curve.
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Note: This method can also be used to extract the closed curve that its image size
is larger than the image area. The closed curve measurement is the quickest and
most effective method to measure the length and area of an irregular close curve,
and also be used to measure the equivalent diameter of a flexible circle (such as a
rubber O-ring).
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3. Result data viewing and tolerance settings

The element list area lists the number and names of all measured elements in the
order of the measurement operation, click on the name of the element to view its
results in the result display area. By default, only part of the results of the element is
displayed, and you can check the "show all" check box in the lower left corner of the
results display area to display all the results data.
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The results data includes actual values, nominal values, error values, upper tolerances,

lower tolerances, and states.

Actual values : The Value obtained by actual measurements.

Nominal values : The Standard values marked in the drawing. The nominal value is
manually entered by the user.

Error values : The error value= The actual value — The nominal value.

Upper tolerance : The difference between the upper limit size and the nominal size.

Lower tolerance : The difference between the lower limit size and the nominal size.

State: According to whether the actual value is out-of-tolerance, there are two states :

OK or NG, the entries will be used red to alert when the state is NG.
(2) The tolerance settings
Including the upper tolerance settings, the lower tolerance settings, the shape
tolerance settings and the position tolerance settings.
@ The Upper and lower tolerance settings
You only need to enter the values of the upper and lower tolerance in the result

display area. The software will determine whether the size is OK or NG according to
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whether the error is out of the tolerance range. The NG entries will be automatically
displayed in red, as shown below:

CIR1 Ref Coordinate System :
Content Actual Nominal Qver UpTol LowTol State
EACenter X 2119 2119 0.000
pACenter Y -2.002 -2.002 0.000
EI_
0114 0114 0.000
D Show All

@ The shape tolerance settings

Shape tolerance: including the straightness, roundness, flatness, cylindricity, etc.

You only need to enter the required range of the tolerance zone in the nominal value
box, as shown in the following figure. For example, entering 2.0 in the nominal value
box, the software will automatically calculate the error every time when the user
program is running, and automatically determine whether the actual value is OK or

NG. The NG entries will be automatically displayed in red, as shown below:

CIR1 Ref Coordinate System:
Content Actual Nominal Ower UpTol LowTol State
[ACenter X 2119 219 0.000
_@Center‘r’ -2. 002 2 002 0.000
IZ 0001 0020 -0.0200 OK ]
U 114 U 114 0.000




® The position tolerance settings

Position tolerance: Including the position, symmetry, perpendicularity, parallelism,
inclination, circular runout, total runout, etc.

As shown in the figure below, double-click an element in the element list area, and
then pop up the position tolerance setting dialog box. For example, selecting
the "PSN" tab to set the position tolerence.

B (=]
> » E B E
= # P | @ ococ| S om0 | D e | 400 muc
{+)CIRZ CIRZ 24 o o Masure Horiozl vy
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[ show Elements Only Ol Tolerence

double-click

Select the "PNTL1" as the reference datum, that is the position tolerance of the "CIR1"
relative to the "PNT1", and then enter the tolerance range “0.02" , click the "Add"
button, the position tolerance will be added to the element list area. (Or you do not
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select the datum element, but manually enter the theoretical coordinate values of the
"CIR1" center in the nominal value box. That is the position tolerance of the “CIR1”
relative to its own theoretical position)

The software will automatically calculate the error every time when the user
program is running, and automatically determine whether the actual value is OK or
NG, the NG entries will be automatically displayed in red.

b ufvifm]n] ﬂ PSN1 Ref Coordinate Sys
) CiR1 CR1 A Content Actual Nominal Over State
[ Target CIR1
[MBasze PMNT1

EjPosition | 0.081

[] show &

D Show Elements Only Over Tolerenge

The Position tolerance has been
added to the element list area

You can follow the same steps to set other tolerances, the definition of all the
tolerance see the "mechanical design manual”
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4. Exporting the measurement results data

(1) Result data export toolbar

The software supports the EXCEL, WORD, TXT, DXF, IGS format document
exporting. The EXCEL or WORD applications must be installed before you export the
EXCEL or WORD documents. Click the EXCEL and WORD exporting button will
automatically start the corresponding application. The DXF format documents is
opened with AutoCAD or the other graphics software. The document exporting

toolbar is as follows:
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The user can set whether to export the measurement results of an element, and

can also set whether to export one item of an element results, as shown below:

| RIS 33 %l
o PNT1 PNT1 1A «
2~ LIN1 LIN1 2

L Pcsi

4 PSN1 PSN1(CIR1)

<= DIS1 DS

*3 INF1 INF1 h
B caL CAL1

CIRECT REC1 il

neen

The element will be not exported
after you have canceled the “V"

CIR1 Ref Coordinate System:
Content Actual Nominal Over UpTol LowTaol State
[ACenter X 218 2148 0.000
_@Cemer‘( -2.002 -2.002 0.000
20012000 0.001
] 0114 0114 0.000
[7] Show &

The item will be not exported
after you have canceled the "V"
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(2) The EXCEL document export settings

Because of the diversification of the EXCEL table requirements, the software support
the EXCEL document settings, click the EXCEL export settings button ‘&E] on the
export toolbar and pop up the following dialog box.

Excel Setiing |-

Defautt [Custom | Shge Mude:

Report Header Option
¥ Tustput Header Prefic
ReportName ] Only Export Blemenits I Controi{Me

¥|Output Elment @) Quiput Attrbut
PartName

| Tolermnca Qubput Masidin CPiCPK [ Time:
PartNo | Sart Befare Expi
Operator
Background color Eont color
Company DK{mora than | [~ i t -

I -
OKlass than O+ oxpesta | — -
== NG background color | I - | NG fort color . -
[ Qutput Graph
Output Irega @ Lne * Row
T fidd to file

OutpuT Map

oK
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@ The table header settings : Check the “Output Header " option to output the
table header to the EXCEL document, you can also enter the report name, part

name, part No, operator and company.

ReportHeader

Report Header

I V| Qutput Headerl

ReportName Tablel A C D
1 | Report Mame : Tablel
PartName  Part 1 2 |Part Mame : Part 01
PartNo 01 = I:'Ell'-t ND : 1
4 | Operator Operat 01
Operator  QOperator01 g Cgmpany : company 01

Company Company01
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@ The part prefix: If you enter the prefix "part”, it will automatically generate the part

name as "partl” "part2" "part 3"...in the table when the software export the reasults

data to the EXCEL document. as shown bellow:

Option
A | B | c | D | E | F |
.- 7
8 onten Diameter | Diameter | Diameter | Diameter | OK/NG
[V Only Export Elements In Control(Ne [ Nominal 2001 2008 2005 3013

Output Element Output Attributs
[] Tolerance ] Qutput MaxMin

[7] Sort Before Expi
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® Only export elements in control : If you check this option, it will only export the
elements have been set the upper and lower tolerance, and the other elements in
the element list will not be exported.

Option

Prefix: Part
Qutput Element Qutput Attribut
[] Tolerance 7] Dutput MaxMin

[[] Sort Before Expi

CIR1 Ref Coordinate System :
Content Actual Naminal Cwer UpTal LowTol State

[ Center X -5.883 -5.883 0.000

0.030 -0.030] OK
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@ Output Attribute name : If you check this option , it will output the attribute name
to the EXCEL document table such as diameter, circle, roundness etc.

Option Attribute name
Prefix: Part A B ; T D
7 /
[V Only Export Elements In Control{Me Content le_ﬂ CIR2- CIR3-
] 3 Diametér | Diameter | Diameter
Output Element Output Attribut 9 | Nominal 2001 2008 2005
, 10|  Partl
[] Tolerance [T] output MaxMin 11| Par2
12 Part3
[ Sort Before Exp ry E—

® You can export other options according to your actual needs, such as graphics,
image, map, tolerance, CP/CPK, time, maximum value and minimum value, and so
on. The “line” and "row” option are set the sort orders of the elements list, and
the "“add to file" option is set to append the current results data to an existing

EXCEL document.
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5. Graphics area and element dimensions

(1) Importing and exporting graphics

@ The graphics area displays the element graphics that have been measured, or the
elements generated by the method of constructing or presetting.

@ The graphics area can display the 2D and 3D graphics. The software supports the
DXF format document importing and exporting, and support the IGS format 3D
document exporting. The exporting of the CAD drawing can also be used for
reverse engineering.
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Graphis Display | Imags Hedgsbon Graphics Display | Image Navigation
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® CAD drawing exporting: Select "File

>Save" in the main menu, and select the dxf

or igs format documents in the pop-up dialog box, Click the Ok button to
complete the CAD drawing exporting ,You can also directly click the CAD export

button on the Export toolbar to copmlete the operation.

CAD importing: Select "File> Open"

document.

ﬁ@ﬁl Preset(P} CS[{C) User Program(F] Imagefl] System Setting

4 D¢ alalal

)
T

MNew M)
Open{0]...
Save(s)

Save as

Open Recently Program files P

Open Fix

in the main menu to import the dxf format

E3Seecie =
P . — |
9.\_‘)1 B Desktop » = | 4y | Search Desktop )
Organize New felder o 7]
i ame Size Itermn type Date modifie
% Computer . s

wd Homegroup

‘L‘E_‘- Local Diske (1)
& Adrinistrater

(ca Local Disle (0:)

. )

s Local Disk () Cormputer
= Local Disk (F) B Network

idocdown

s Local Disk (G)
% ovp RW Drive H] |
4% Share (11192168

niujingsyongyingyu..
tu

= fop]
= i : ' KB \D Draning..
€ Network T Drawingl.di 24 KB D Draning
] test.dxf 17KB  AutoCAD Drawing., S 2
b

(I

File name 2017-0507-1855.xf
Save astype | Auto CAD file(".daf)

T 0
AutoCAD filsl™ drf)

e} thes(".igs)
5]

* Hide Folders
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(2) element dimensions
The dimension toolbar is shown below :

Graphics Display
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@ Select the element to be dimensioned, and then click the corresponding button on
the graphics toolbar to display the element dimensions. If you want to mark the
dimensions between the elements, both elements should be selected at the same
time and click the corresponding dimension button on the graphics toolbar. You
can hold down the left mouse button and drag the dimension.

@ You can click the triangle symbol on the right side of the dimension button and
select whether to mark this type dimensions automatically.

® If the user program is running, the software will automatically update the
dimension values.

@ You can rotate, zoom in, hide the Geometric graphics in the graphics area, or
perform the other operation by using the functions of the graphics toolbar,
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Chapter 7 Element Construction and Presetting

1. Element Construction

(1) The definition and use of the element construction

The element construction is to generate a new geometry element with the

Existing geometry elements.

For example, generating a line with 2 Existing points, generating a circle with 3
Existing points, In additon, the element construction is often used to generate the
element that can not be measured directly, such as the distance, the angle, and so on.
The construction elements are usually used in some auxiliary measurements, for
example, using the construction elements to establish the coordinate system. The

element construction toolbar is as follows:
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(2) The steps of the element construction
Take constructing the following vertical line from the center of the circle to the line as

an example: R R R

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaa

Step 1: Hold down the "ctrl" key on the keyboard, and then select all the elements to
be used to construct in the element list area. (You can also select al these

elements in the graphics area)




Step 2: Click the corresponding construction button on the Construction toolbar,

A4 O\c:b

D
et

Step 3: If the element has a variety of construction methods, it will pop up the
construction method dialog box, check the required method, then click the

OK button to complete the operation.

UN - CIR @ L5 (T {00 | alalalgle|L]4] olninsiEm
[T Parallel [¥] Vertical [T Mirror image ‘
[ select al I
v
| Cancel | [ Ok J &
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(3) Element construction method
According to different elements, the construction methods includes extraction,

intersecting, tangent, vertical, parallel, mirror, translation, composition, symmetry and
so on. The following describes some methods of the element construction

@ Constructing points

The common methods of constructing points are as follows:

\/@

<

Construct the center point

Construct the intersection point, the
symmetry point, the vertical point, or the

of an element i '
tangent point of the associated elements

90



® Constructing lines

The common methods of constructing lines are as follows:

o ) \ )
Construct the connection and Construct the internal common Construct the parallel line,
symmetrical line of two points tangent, external common tangent, vertical line, and mirror line with
center connection of two circles a pointand a line

~

“—\.

Construct the tangents and

Construct the angular bisector and Construct the connection of

connection from a point to a

angular mirror line of two lines two element centers

circle center
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® Constructing circles

The common methods of constructing circles are as follows:
) Q
. . Q

. ] Construct the distribution circle, . . .
Construct the circle with . Vo \ Construct a mirror circle with
. the excircle and the incircle with . .
three points ) acircle and a line
at least 3 circles

@ Constructing angles

You can construct the following angles with two lines:

.
e e e e e D ——
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® Constructing distances

The common methods of constructing distance are as follows:

() //

¢ o —_

Construct a vertical distance from Construct the midpoint distance and the

Construct the distance . . .
point to line or the distance to the

. endpoint distance between two lines
between two points S .
midpoint of the line

o M |
N\ |

Construct the center distance, and

Y Construct the vertical distance Construct the center distance
the nearest or the longest distance . . .
from a circle to a line between two circles or any two
From a point to a circle
elements
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® Constructing a plane

The common methods of constructing a plane are as follows:

H E &

Construct a plane with Construct a plane through a Construct a plane through a point

three points point and a line and perpendicular to a line

@ Constructing cylinders and cones

B &

Construct a cylinder with two circles Construct a cone with a circle and a
that are not on the same plane point outside the circle plane
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2. Element Presetting

Element preseting refers to manually inputting parameters to generate an
element. For example, generating a point by manually entering the coordinates of
the point, generating a circle by manually entering its center coordinates and radius.
The software supports to preset the point, line, circle, plane, cylinder, cone, and
sphere. Select the "preset” menu option, and select the element you want to preset,
then enter the parameters in the preset dialog box, you can generate the element in
the graphics area. Element preseting is also mainly used in some auxiliary

measurements or comparative measurements. BT <)

® Plane | @ Sphere @ Crlinder | & Cone
® Feint 4 Lina O Ctircle

File{F} {Préseﬂﬁﬂ CS[C) User Program{P} Imagefl] System Se Center

év'o Paint l@,l@v{{(’q'l Q|Q|F 11, 2

/A Line
!_{_:} Circle

: Plane H Badins

@ sphere Fediwe 10|
8 Cylinder
& Cone

I I 1}

a1

Add
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Chapter 8 Coordinate System
There are two kinds of coordinate system in the image measurement: the machine

coordinate system and the workpiece coordinate system, which are all right handed

Descartes Cartesian coordinate system,

1. Definition of the coordinate system

Machine coordinate system: The origin of the machine coordinate system is a fixed
point relative to the machine worktable. When the three motion axes stop at the
origin position, the machine coordinate origin and the detection center of the image

measuring instrument coincide with each other. The machine coordinate system is the
measuring datum. It is fixed and can not be changed.
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Workpiece coordinate system: The origin of the workpiece coordinate system is a

datum point on the workpiece

coordinate system as required,

Workpiece coordinate system

Machine coordinate system

Worktable

. You can arbitrarily create or change the workpiece

Workpiece
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2. Creating coordinate system
(1) Establishing the machine coordinate system (Go Home)

The machine coordinate system is inherent, you does not need to create the
machine coordinate system. It will prompt to find the Home Position as follows when

the software is opened. The machine coordinate system is automatically established
after the Home Position was found.(Note: Here finding the Home Position is to find

the origin of the machine coordinate system)

[ Go Home 1

Finish

Finish X
Finish ¥
Finish Z

Skip
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(2) Coordinate toolbar

The coordinate toolbar is as follows

Axes Spatial rotation

|

Create the coordinate origin — }EL | S

XY axes alignment — | L . | : +7Construct the coordinate

system by the probe

l— Save the coordinate system
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(3) Steps to create a workpiece coordinate system
@® The XY plane of the workpiece coordinate system used by the user is usually
parallel to the XY plane of the machine coordinate system, in this case, the steps to
create a workpiece coordinate system are as follows:
Step 1: Extracting or constructing the elements used to create the coordinate
system.These elements include the element to establish the coordinate origin
and the element to establish the axis direction. Fox example, extracting a

datum point and a datum line as follows:

[« /|o|r|eo|olo|lo|a|g
A8 VP &
©|O|]¥ &+ 9| e

[T ST A o o

abdie] s

A

O=8la

/

Extract a datum point  Extract a datum line
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Step 2: Establishing the workpiece coordinate system origin : Select the "PNT1"
element in the element list area as shown below, click the button [9 - on the

coordinate toolbar, and then the coordinate symbol will appear immediately

in the position of "PNT1", 3
ARt ol £
Fo— ¥ iloins
® &|~|% %
of B
e _— dl il )[4 The coordinate symbol
PHTT - 8 4" \
PNT Tizar J.ﬁ .! JE
]

The element used to create the coordinate origin can be a point or other
geometric elements. The software will take a point or automatically extract the
center points of other geometric elements as the coordinate origin. as shown

— S O[3 S

Point Midpoint Center Center Center

below:
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Step 3: Axis alignment: Select the "LIN1" in the element list, click the button& on
the coordinate toolbar, The software will make the direction of a coordinate
axis parallel to the "LIN1". The X-axis color of the coordinate symbols is red,
and the Y-axis color is green. By default, the software align the axis that its
angle is relatively smaller with the "LIN1", it may be the X or Y axis. You can
also click the triangle symbol on the right side of the buttong to chose to
align the X axis or the Y axis.

Rlzzl=lel 1 lml4

[® of~]3

|| Show Elemantz Only Over Tokrence * / O r

LMt - 9 a4
2

LI Boundary .LD‘ 4 15 4 JE_
S5

The coordinate is aligned
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The element used to align the coordinate axis can be a line or other geometric
elements. The software will make the direction of a coordinate axis parallel to the line

or coincide with the connection between the coordinate origin and the center points
of other geometric elements, as shown below:

;//./Q/O

Parallel Coincide Connect Connect Connect

103



Step 4: Save the coordinate system. Click the button \E‘ on the coordinate toolbar
to save the coordinate system, then the "TCS" coordinate element in the
element list area immediately becomes the "PCS" element (Note: The

“TCS” coordinate is a temporary coordinate system, it must be saved after it

has been established, otherwise the temporary coordinate system can be lost
when you do other operatons.

PNT1‘_J / ,6 &
NN
[© o|~[3
®

|tl Show Elementz Only Over Tolerence ;HQ‘E
PC51 - . ‘ H
e 5 2

e
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@ The steps to create the three-dimensional coordinate system

There are two methods as follows:

Method 1: Extract elements to construct a three-dimensional coordinate system with
image, laser or probe. Take the following 3D model as an example, the
steps are as follows:

Step 1: Extracting a datum plane: Extract the plane A directly with the probe or laser,
or construct the plane A with the points extracted by focusing measurement.
Extracting a line element: You can first extract the plane B, and then construct
a line with the plane A and plane B.

Extract a point element: You can extract the point by the method of

projection or element construction. Extract the plane A

NI ni x1 z Y
o PN PLN1 164
2 LIN LM1 2

§ - FNTI PNT1 a2

L -

Extract a point

[~ show Ekements Only Over Toierence:

Extract a line
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Step 2 : Space coordinate axis alignment. Select the plane that has been extracted
in step 1, and then click the triangle symbol on the button J3 -, and select
the “Space Rotate as Z " in the pop-up menu.

ST i [» 3% Click this triangle symbol
2 LIN1 LIN1 24
= PNT1 PNTA 3o [D - I 5_ - [n. - T =
o LTCs 4 e EJ m
I L . Space Rotate As X
Space Rotate As ¥
Space Rotate As £
|:| Show Elements Only Over Tolerence

Step 3 : Estabishing the coordinate origin. Select the point extacted in step 1 in the

element list, and then click the button J% -lon the coordinate toolbar to
establish the position of the coordinate origin,

| NI »| X
- PLN1 PLN1 1~
LIN1 LIN1 2|
» LTCS 4|

Lg -

|:| Show Elements Only Over Tolerence
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Step 4 : The second coordinate axis alignment. Select the line extracted in step 1 in
the element list, and then click the button J& -| on the coordinate toolbar to

align the second coordinate axis,

| TR »| X
s PLH1 PLN1 |
= PNT1 PNT1 3|
y LTCs 14
» -

|:| Show Elements Only Over Tolerence

Step 5 : Save the cooridinate system. Select the "TCS" in the element list, and then
click the button J_F! on the coordinate toolbar, and the workpiece

coordinate system is created sucessfully.

1] » E
w PLNT PLNA 14 0 5 H
LIN1 LINY 2~ ~ ~
« PNT1 PNT 3

i

|:| Show Elements Only Over Tolerence
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Method 2 : The method creating a three-dimensional coordinate system Specifically

for the probe measurement.(Note: The probe measurement see Chapter 11)

Click the button Jﬂ -/ on the coordinate toolbar, select the elments combination

type used to create the coordinate system in the pop-up menu according to actual

requirements, and extract the required elements in order with the probe in the

pop-up dialog box.

belks g+ |©

3-21

Plane-Plane-Plane

Plane-Line-Line
Plane-Line-Circle
Plane-Circle-Circle
Cylinder-Point-Line
Cylinder-Point-Circle

k1) - J
= -

e}
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(3) The multilevel coordinate systems

The multilevel coordinate systems refer to creating new coordinate systems base
on the current workpiece coordinate system. Some easily deformed or bent
workpieces can be measured by creating multilevel coordinate systems. For example,
creating the workpiece coordinate system "PCS 2" base on the current "PCS 1", and

then creating the workpiece coordinate system "PCS 3" base on the current "PCS 2" ...

(4) How to create the coordinate system when running the user

program

Every time when the software executes the user program, it will extract the
elements to be used to create the coordinate system with the Find-Edge-Tool that
draw by the user . There are 3 element extraction methods: “manual” , “half auto” ,
and "auto” . You can select the “User program->Method of create coordinate
system” in the main menu to choose one of these 3 methods. In the batch
measurement, if the position of the workpiece have been changed greatly relative to

its original position, in order to prevent the elements used to create the coordinate
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system out of the area of the Find-Edge-Tool, you can choose the “manual” menu

option ; When the workpiece is precisely positioned by the fixture, Its position

changes little, ane the elements can not be out of the area of the Find-Edge-Tool, in

this case, you can choose the “Auto” or the “half auto” menu option.

File(F}] Preset(F} C5(C) | User Program(P} | Image(l}] System Settings(3) Tools(B] Help(H)

I | Method of Create Coordinate System

A -

A, -

b -

»

Manual

Run
Pause
Continue
Stop

Repeat
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3. Coordinate rotation, translation, and mirror.

You can select the "CS" menu option to translate, rotate, and mirror the workpiece
coordinate system. As shown below:

FilefF} Preset(F) | C5{C) | User ProgramiF} Imagef]

& | % -

System Settings(5) ToolsiB} HelpiH

Coordiate translate

. EY
4 ! - QIQ|A|8] 5% @
Coordiate rotate —
Mirrar
Translate @ Rotate @ Mirror reflect
x: 20 @x
y: 10 Angle: 42
Z: 0 i
OK l I Cancel oK ] l Cancel oK ] | Cancel
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4. Workpiece coordinate system transformation

(1) coordinate system transformation
You can click the status bar below the software interface to transform the
coordinate sytem, The coordinate system can be transformed to the machine
coordinate system or any workpiece coordinate system. The coordinate system
shown in the status bar is the “Current Coordinate System", and the coordinate
display area displays the current coordinate data. The coordinate data color is green
when the current coordinate system is the machine coordinate system, otherwise the

coordinate data color is yellow. All measurements are based on the current

coordinate system.
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CARTESIAN

Click here to transform the
current coordinate system
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(2) Coordinate system mode

The software displays the measurement results data in two coordinate system
modes: the "Coordinate mode 1" and the "Coordinate mode 2", which can be
switched by double-clicking on the status bar.

Coordinate mode 1: In this mode, the reference coordinates of the results data can
be selected. When you want to observe the results of a certain element in any
coordinate system state, you can first choose the "coordinate mode 1" in the status
bar, and then click the the reference coordinate system in the upper right corner of

the result display area.
coordinate mode 1

CIR1 Ref Coordinate System: [acsy vI_

o

o i
= 4
=l 1 lm

A Content Actual Nomina | Qver UpTol Lowes
" Center X 2295 2295 0.000
MCenter ¥ 11.182 11182 0.000 Eggi
k9 [ADiameter 2199 2199 0.000
- | i __§ BT 0031 0.031 0.000 f
- L Show Al
[#/o|o Double-Click here to switch
wiii | the coordinate mode The coordinate system is optional

[ 11145 /
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Coordinate mode 2: In this mode, the reference coordinate system of all elements is
fixed to the current coordinate system and can not be arbitrarily selected. When you
want the results data of all elements to be displayed in a certain coordinate system,
you can first switch this coordinate system to the current coordinate system, and

then choose the "coordinate mode 2" in the status bar.

: Click here to switch

the current coordinate

S Mo e oo CARTESLLN

\ Double-Click here to switch

the coordinate mode

-l

glEi

Cl

1

coordinate mode 2

Ref Coordinate Svsteml I

MT

[ACenter X
[ACentery
[#Diameter

Actual Nominal Over UpTol Lowsi State
-3.007 -3.097 0.000
7271 7211 0.000
2199 2199 0.000
0.031 0.031 0.000

Show All
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The workpiece coordinates can also be transformed between the Cartesian coordinate
and the polar coordinate. You can double-click the position as shown below in the
status bar to transform them.

Srmm

| CEModel mim oD

transformation between the Cartesian

coordinate and the polar coordinate
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Chapter 9 User Program

1. Creating, opening, and saving user programs

You can select the "File > New" menu option to create a new user program, and you
can also choose to open the exsisting user program, or save the current user program
to a folder. The extension of the user program is ".ins"

NewN) 3,| =f=*v| Q|Q|A|@‘b

Open{d]...
Save(s)

=

Save as

Open Recently Program files P

Open Fix
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2. Creating, executing and modifying the user program

(1) Creating the user program

The software records the steps of the measuring, constructing, and moving
operation in sequence, and generates the elements. These elements displayed in the
element list area in sequence, and the user program is automatically created.
(2) Executing the user program

You can execute the user program by clicking the Run, Pause, Continue, Stop, and
Repeat button on the User Program toolbar. The software automatically measures the
elements in the element list area one by one when executing the program. You can
also set whether the measurement results to be automatically exported at the end of
the program execution (How to automatically export the results see the user program

settings described later) Program Toolbar —— [ [-[ ] x|

1

Hrom CIRt
L pPost
4 P PEN{CIR )

Element list area — =

MR caLt CaLt

LRUREQRKR

o CIRECT RECA
>

|| Show Elermenis Only Over Tolerence
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(3) Modifying the user program

Click on the right mouse button on a certain element in the element list area, you
can insert an element or a step in the list by selecting the "insert" menu option, or
selecting "Reset store position" to change the position of the element in the list, thus
to change the order of the program. You can also make other changes to the user

program.

Insert

Cancel Insert

Set User Name

Search

Reset store position

Graphics Display Edit element mask

» Select all

o PHT1 Delete 16
LN Cancel 2[A

A

LPC31 apA

& PSN1 PSN1(CIR1) s
4=p OIS oISt )

*$ INF1 INF1 )
CALT CAL1 afet

w [JRECT REC1 9@_

P
|—| Show Elementz Onby Owver Tolerence
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3. The Find-Edge-Tool settings

You can set the Find-Edge-Tool parameters of an element in the program. Such as the
light source parameters, the edge parameters, and whether to autofocus. When using
the “subsection” method to measure the elements, you can also set the
Find-Edge-Tool of each segment. Click on the right mouse button on an element in
the element list area, chose the "Set Find Edge parameter" menu option, open the

dialog box as follows:

L e L
Move to center{laser) CIR1- Find Edge Tool 52
Set Find Edge Parameter
S ELB N
Figure Tolerance Diagram tooll - | [Move To mig,l’]! Lziiz)
Re-measure
Reset z-coordinate 4% LightData [[]Put current light data inte this Find
Start Measure Here Edge Taol
Insert ¢ Find Edge Param [[]hpply with 11 Find Edge Tools in this
Cancel Insert | ———— element
| Graphics Display [ Set User Name “J', Auto Focus
search
»
R Reset store position 3F -
Lpcst Edit element mask Ll
4 PSN1 Selectall 54
w=»DIS1 604
4 F1 Delete 12
[ caLt Cancel s &
=)
®cR2 cR2 A CAMNCEL AFPLY (A)
o CR3 CIR3 LI~
P %

D Show Elements Only Over Tolerence
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You can make the following settings in the “Find Edge Tool” Settings dialog box

(1) Light source data :

You can overwrite the current light source data of a certain “Find-Edge-Tool” with
the surface brightness value and contour brightness value that hase been set on the
“light source adjustment panel” , or overwrite the light source data of all elements.

(2) Find Edge parameter :

You can set the threshold, precision, and burr size of the “Find-Edge-Tool” for
the selected element.

(3) Auto focus:

You can set whether to autofocus in the position of a certain Find-Edge-Tool, and
you can also reset the size of the Find-Edge-Tool.

(4) When using the “subsection” method to measure the elements, you can
select the “Apply to all tools in this element” option , and you can also choose to
set the other Find-Edge-Tools of this element by clicking the drop-down triangle
on the top right corner of the dialog box.
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4. User program settings

Click the “program settings” button on the User Program toolbar to open the

Program Settings dialog” . As shown below:

JEIEIRES E5

“"User

() CIR1 CIR1
Lpcsa
4 P3HA PSNA(CIRT}
4= DIS1 DIS1
1 INF1 INF1
M caLt cALi
CIRECT REC1
{(¥1CR2 CIRZ

. (DICIR3 CIR3

[

|:| Show Elementzs Only Over Tolerence

User Program Setting Dialog

Speed of Running
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Some options in this dialog box is discribed as follow:

(1) Speed of running : The speed of the movement between the elements when the
program is running, and you can lock this speed to a certain value.

(2) Find Edge delay : How long to start extracting the element after the machine
movement is stopped.

(3) Export to EXCEL: It will automatically export the EXCEL report after the program
was finished each time.

(4) Go to first element : The center of the image area will return to the original
position after the program was finished.

(5) Go to specifacation position : The center of the image area will move to a certain
coordinate position after the program was finished.

You can also check other options to set the user program.
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5. The “Goto Point”

When moving from one element to the next element, the default movement trajectory
is the shortest straight line between these two elements. The collision must occur if
there is an obstacle between these two elements. So the Goto points must be set on

the movement trajectory to avoid the collision. As shown below:

GotopointB

® GotopointC
obstacle \.
bstacle

o
Lens /
W Lens

workpiece

2
workpiece”

Error: There are no Goto points Correct: The Goto points have been inserted
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The steps of setting Goto points are as follows: To make the lens bypass the obstacle
from the point A to the point D, you must move the lens along the point in the order
of A>B->C->D, and click the Goto point button at each position of AB,C,D. All the
Goto points will be shown in the element list area. The machine will move along the
Goto points when the program is running

28

P P a:

b|||‘>|| »|3€|

+3 INF1 INF1 1[4
+¥ INF2 INF2 264
*1 INF3 INF3 3

|:| Show Elements Onby Over Tolerence
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Chapter 10 Practical measurement functions

1. The elements translation and matrix

When there are many equidistant elements on the workpiece, you can first extract
one of these elements, and then generate the remaining elements by using the
element translation or element matrix function. It can save a lot of time to extract the

elements. Take measuring the holes of the following workpiece as an example.
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Step 1: Extract the first hole in the lower left corner of the workpiece image.

1mm |

|l | 1 |4

LA |
[

I3

X = -HR.4PRT. Y = BEHIR] |
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Step 2: Click the right mouse button on the circle element in the element list area,
select the "Translate” menu option, select the matrix tab in the “Translate”
dialog box, enter the offset value of the matrix and the number of copies, click
the OK button to complete the operation. (Note: The number of copies does

not include the original element).

Fart Calibration e
Translate ]

Rotate
Translate
Move to element center @

Move to Center(Standard Center] L Matric
Inear

Mave to center(laser)

Set Find Edge Parameter

Figure Talerance Diagram Offset
Re-measure Copies
Reset z-coordinate X 2 5
Start Measure Here
Y2 5
Insert
Cancel Insert @ X First (©) Y First

Set User Name

Search

Reset store position

e .
Edit element mask [ Move lke a snake

Graphics Display | Image H Select all
> Delete
142
Cancel
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Because the location where the workpiece is placed is uncertain, the matrix circles may
not coincide with the circles on the workpiece image, so you need to align the matrix

graphics and the actual workpiece image.

1 4

=N

5]k
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Step 3: Right-click any element in the element list area. Select the "part calibration”

menu option, and then click the “OK” button in the pop-up dialog box.

Fart Calibration

Translate

Rotate

Move to element center
Maove to Center(Standard Center)
Move to centerflaser)

Set Find Edge Parameter

Figure Tolerance Diagram

Re-measure @

Reset z-coordinate

o l , You can operate according to the status bar tips.
art Measure Here LB

Insert

Cancel Insert

Set User Name

Search

Reset store position

Graphics Display Edit element mask

Select all
B e Delete
5 CR1 Cancel )
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Step 4: According to the prompt of the status bar in the lower left corner of the
software interface, select the first element in the graphics area as shown below.
Click the OK button in the pop-up dialog box. Then according to the prompt of
the status bar, extract the first corresponding circle in the image area.

2104F 1 alajAle[v|- |4 ¢|u|nsE@

Tom T

||+

S (N (I

Umalenl1

Select the first element |

e

(31K

=l
I Select the first characteristic element finish!
4 X =-hR.4787. Y = RRAIRT |
Extract the first circle
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Step 5: According to the prompt of the status bar in the lower left corner of the
software interface, select the second element in the graphics area as shown
below. Click the OK button in the pop-up dialog box. Then according to the
prompt of the status bar, extract the second corresponding circle in the image
area.

210 {r ] Qa8 v]-[5 o||=|2]E @ —

1 lml+

i J | | Fil ) |

b F=1 TS

5k

I Select the second characteristic element finish!
:

Extract the second circle
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Step 4: Click the OK button in the pop-up dialog box to complete the alignment. And
the matrix graphics and the actual workpiece image is aligned. Click the Run
button on the user program toolbar to automatically measure each circle

element on the workpiece image.

=

Part calibration finish! j

l._ a cahoratuon ninsn! E
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The above translation and matrix functions apply only to the equidistant matrix
elements. If the element array is not equidistant, you can use the method of importing
CAD drawing to measure it, described as follows:

2. Comparative measurement with the CAD drawing

The software supports the method of using the CAD drawing as a template to
measure the workpiece. It can be used in the coordinate measurement or the
comparative measurement. This function is applicable to the workpiece of any shape
in the range of the instrument measuring.

Because the location where the workpiece is placed is uncertain, the CAD drawing
may not coincide with the image contour, so you need to align the CAD drawing and
the image contour. In addition, according to the different datums of the comparative
measurement, it is divided into two ways: The entity datum alignment and the virtual
datum alignment.
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(1) Measuring base on the entity datum
Step 1: Draw the standard drawing of the workpiece with the CAD software and save

it as a dxf format document. As shown below :

@ @
@,

W OO
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Step 2: Click the "File > Open" in the main menu, select the dxf file type in the pop-up
dialog box, and select the corresponding file that you want to import,and then
click the Open button to import the CAD drawing into the graphics area.
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Note: The software can automatically identify the points, lines, arcs, circles, and
curves of the CAD drawing, and display these features in the element list area one
by one in the form of elements. Because the location where the workpiece is
placed is uncertain, the CAD drawing may not coincide with the image contour, so
you need to align the CAD drawing and the image contour. As shown blow:
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Step 3: Align the CAD drawing and the actual workpiece image. Right-Click any

element in the element list area, select "Part Calibration” menu option, and

then click OK button in the pop-up dialog box.

Graphics Display | Image R
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Search
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Delete
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Step 4: According to the prompt of the status bar in the lower left corner of the
software interface, select the first element in the graphics area as shown below.
Click the OK button in the pop-up dialog box. Then according prompt of the
status bar, extract the first corresponding line in the image area.
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Step 5: According to the prompt of the status bar in the lower left corner of the
software interface, select the second element in the graphics area, click the line
element with the mouse as shown below. Click the OK button in the pop-up
dialog box. Then according prompt of the status bar, extract the second

corresponding line in the image area.
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Step 6: Click the OK button in the pop-up dialog box to complete the alignment of
the CAD drawing and the workpiece image contour.
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Step 5: You can perform comparative measurement for the workpiece after the
alignment, and if the contour feature is outside the image area, you can move
the feature into the image area for observation. Or you can also perform the
coordinate measurement for the workpiece by clicking the “run” button on

the user program toolbar.
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(2) Measuring base on the virtual datum

In some condition, the the user required perform the comparative measurement base
on the virtual datum. Take the following workpiece as an example, you must create
the virtual datum in order to observe whether the 4 circles are symmetrical to the
center lines of the rectangle

The center lines of the rectangle

The CAD drawing The workpiece image
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Because they are virtual datums, so you need to establish the virtual datum by using

the construction method, that is to create the workpiece coordinate system with the

construction element. Then align the CAD drawing and the workpiece. The steps are

as follows:

Step 1: Hold down the "ctrl" button on the keyboard, select the four sides of the
imported drawing to construct a rectangle.
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Step 2: Create a coordinate system with the rectangle, and align the coordinates with
one edge of this rectangle, save the coordinate system. Then the coordinate
system is created in the center of the rectangle, the X-axis and the Y-axis of the

coordinate system can represent two symmetrical center lines.
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Step 3: Align the coordinates of the CAD drawing and the workpiece. In order to
perform coordinate alignment without performing the coordinate
measurement, you need to click the “Program Setting” button on the user
program toolbar and check the “Finish program once BCS finished” option in

the dialog box, and then click the OK button to exit the user program setting.
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Step 4: Select the “user program->method of create coordinate system->manual” in
the main menu, and the method of creating coordinate is set to manual when

the program is running.

File{fF} Preset(P} (CS(C) | User Program(F] | Imagefl] System Settings(5] Tools(B] Help(H]
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Step 5: Click the "Run” button on the user program toolbar, and then measure the
corresponding contour line for constructing the rectangle in the image area in
the order of the element list area. After the measurement is finished, the
program will automatically align the CAD drawing and the workpiece image

contour, and then you can perform the comparative observation.
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3. The fixture array and the macro array

These two functions are used for the CNC image measuring instrument, the manual
image measuring instrument can skip this section.
(1) The fixture array measurement

In batch mearement, a lot of the same workpieces placed on a fixture are basically
equidistant, you can measure one of the workpieces first and then use the fixture array
measurement function to measure all the workpieces on the fixture. You can save time

greatly and simplify the user program by using this fuction. As shown below:

g g /The workpiece
[m] u
g q// The fixture
[m] [m]
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Step 1: Create the workpiece coordinate system based on the first workpiece on the
fixture (Accroding to the actual need you may not need to create the
workpiece coordinate system), then extract the measured elements, and save

the user program.

= b
FileF} | Presetif}  C5E3 User Program®  Tmagel)  Systén Selftingu'S)  TookiE)  Helph)
Bird alalalele|r4 ¢n|nlsE 0| x., x E A T
D O v I + Ve

gl®
@
|
g
£
v leerla

q_lTIQ) & |o|ojo|e|s|B
@ ale[veE

[0 o|n|v|al et

mliwlr

[ Ehew Elements Dnky Qver Toerence

150



Step 2: Select the "File>New" in the main menu and then create a new user program.

:| File(F) l Preset(F] (©C5{C) UserProgramiF] Imagefl] System Settings
L] New(N) J
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H Save(s)

Save as

Open Recently Program files P

| Open Fix

Step 3: Select the "File>Open Fix" in the main menu, then select the "Fixture>New"

menu option in the pop up fixture window.
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Step 4: Click the "Select default user program” button in the fixture array setting

dialog box, select the user program has been saved in Step 1, enter the

number of the rows and columns, and enter the horizontal and vertical

distance between the workpieces, and then click the “confirm” button to

complete to set the fixture array, click the OK button to generate the fixture

array program.
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Step 5: Because the location where the fixture is placed is uncertain, you need to align
the coordinates of the created array and the actual fixture array. Select the
"Coordinate system->Build fixture Coordinate” menu option in the fixture

window.

Fixture
Coordinate System(C) | Ficture
Build CFiodure Coordinate Me
..... I
4 13 14
3 g 10
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Extract an element in the image area, as shown below, you can extract a circle, and
then click the circle in the element list area, click the button % -/ on the coordinate
toolbar, so that the origin of the coordinate system is built on the the center of the

circle.
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Move the image area as far as possible from the first workpiece, and then extract the
same element in the same position of another workpiece, select the circle in the
element list area and click the J& - button. Finally, click the J—F'- button on the
Coordinate toolbar to save the coordinate system. Finally the direction of the created

array and the actual workpiece are aligned.
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Step 6: Save the fixture array. Select the "Fixture>Save" menu option in the fixture
window to save the fixture array program to a file. The extension of the fixture

array file is "fpg” .
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Step 7: Running and editing the array program. Click the Run button on the array

toolbar to measure the workpiece on the fixture one by one. Right click on any

workpiece number in the fixture array window, and then select a certain option

in the pop-up menu, such as setting to Skip this position if there is no part, or

reset the distance to fit to the actual position of the part and so on.
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(2) The macro array measurement

The macro array measurement is used in the multiple fixtures measurement, You

can replace the fixture without stopping the machine when the measurement of the

workpieces on a fixture is finished. This function can greatly reduce the time and

improve efficiency. Take the following two fixtures as an example.
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Step 1: Follow the above steps of the fixture array measurement, create and save the
abave two fixture array programs for abave two fixtures.
Step 2: Open the fixture window, Select the "Fixture> Macro" menu option, click the
"Add" button in the pop-up dialog box, and add the two array files that have
been save in stepl to the list area.

Macro Setting E
Fixture File list
Coordinate System(C) I Fixture D:\TEXT1.fpg
D:\TEXT2.fpg

Il p| B D) New

Open

Save

Clear Base

Macro

| I | Delete
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Step 3: Close the "Macro Setting" dialog box when you have finished adding the array
files, click the “Run macro” button on the array toolbar. The program will

control the machine to measure the workpieces on all fixtures.
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4. The scanning function

The scanning function is to generate point clouds by scanning the workpiece image

contour. It can be used for reverse engineering. There are 3 methods described as

follows:

Method 1: If the image size of the workpiece is small, it can be imaged entirely
inside the image area, the scanning steps are as follows:

Step 1: Click the “scan” button on graphics area toolbar. In order to reduce the

miscellaneous points, it is recommended to turn off the surface light before
scanning and illuminate with the contour light.
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Step 2: Double-click in the image area to get the workpiece contour of the point
clouds, and right-click in the graphics area and select the “save data” menu

option to save the contour as a dxf format document.

Il sl 1 lml4

Begin scan

Save data

Clear all

Exit scan
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Method 2: If the image size of the workpiece is larger than the image area. it can
not be imaged entirely inside the image area. Take the following

workpiece as an example, the scanning steps are as follows:

163



Step 1: Click the “Scan” button on graphics area toolbar, and click the right mouse
button in the graphics area and select the "Begin Scan" menu option, and the

"Scan workpiece Settings" dialog box is displayed.

Scan workpiece setting @
Lefttop
¥ -23.999 [ Resd |
Y:  52.675
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Clear all
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Cancel

164



Step 2: Move the top left corner of the workpiece to the center of the image area and
click the "Read” button at the top of the dialog box. (Note: Do not close the

dialog box now.)
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Step 3: Move the bottom right corner of the workpiece to the center of the image
area and click the "Read" button at the bottom of the dialog box.
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Step 4: Click the OK button, the software will control the machine to perform the
jigsaw scanning for the workpiece, after the scanning is complete, you will get
the point clouds contour of the workpiece in the graphics area. Click the right

mouse button in the graphics area and select the “Save data” menu option to
save the contour as a dxf format document.
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Method 3: Scanning any shape contour with the point scanning function.
Step 1: Click the "Point" element button and the "Subsection" method button, Pop up

the "Select path mode" dialog box, select the corresponding element type of

the measured image contour, as shown below, such as the straight line, circle,

arc, open curve, closed curve. Click the "OK" button to complete the operation.
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Step 2: Extract the starting point and the direction point with line intersection method.
Enter the number of points to be extracted in the pop-up dialog box, and the

software will automatically scan the image contour.
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The following describes the ways of extracting points according to different elements.
Straight line scanning: Scanning a straight line need to extract 2 points. The first
point is the starting point, the second point is the end and direction point.

Circle scanning: Scanning a circle need to extract 3 points. The first point is the
starting point, the second point and the third point are the points on the circle.

Arc scanning: Scanning an arc need to extract 3 points. The first point is the starting
point, the second point is the direction point, and the third point is the end point.
Open curve scanning: Scanning an open curve need to extract 3 points. The first
point is the starting point, the second point is the direction point, and the third point
is the end point.

Closed curve scanning: Scanning a closed curve need to extract 2 points. The first

point is the starting point,and the second point is the direction point.
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5. Comparative measurement with auxiliary lines and rings

Choose the "Image->Cross settings" in the main menu , check the "Show

assistance line" or " Show ring(s)" option in the Cross Set dialog, and enter the value
of the angle or diameter. You can generate auxiliary lines or rings in the image area,

you can compare the actual workpiece contour with the standard auxiliary lines or

rings. In addition, you can also compare the actual workpiece contour with the

standard graphics created by the constructing or presetting method.

Cross Set Dialog

Cross Line Set

==

\ Center Set
Line Style: — — — — — « Mouse Sel Center
Assistant Line

V| Show Assistant Line /| Show Ring(s)

Angle: -45 Add Diameter: 15 Add
NO. Angle i NO. Diameter G
1 30.00 E 1 5.00 E
2 210.00 2 10.00
3 135.00 3 20.00
4 -45.00 S 4 25.00 S

Del. Del. Al Delete Delete All
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6. The comparative measurement toolbar
You can observe the length, angle, distance and other features by the comparative

measurement toolbar . As shown below:
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(1) Quick angle observation

Click on the "Quick angle " button, there will appear two dynamic angle lines on
the cross lines in the image area, hold down the left mouse button and drag these two
dynamic angle lines to coincidence with two edges of the measured angle. This
function is only applicable to the angle that its vertexa is at the center of the image

area (You can also move the vertexa of the angle to the center of the cross line).
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(2) Measuring by drawing two angle lines
Click the "Angle" button, draw two lines on the two edges of the angle in
Anti-clockwise order, you can see the angle value between the two lines. This function

is applicable to the angle at any position.
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(3) Two point distance
Click on the " distance from 2 point " button, and then click the left mouse button on
any two pixel points in the image area, you can measure the distance between these

two pixel points.
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(4) Distance from a line to points

Click the "Distance from a line to points” button, click two points on the datum
edge of the measured image in the image area, a dashed datum line will appear, move
the cursor to a step of the measured image, click the left mouse button, you can pull
out the dimension, And then move the cursor to the other steps to pull out the other
dimensions. This function is used to measure the height of different features based on
the same datum.
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(5) Other functions of the comparative measurement toolbar
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Freeze image: Click the “Freeze up” button m«, the image will be frozen, you can
measure the frozen image. -

Find Edge Settings: Click the “Find Edge Settings” button |§ ,You can set the
Parameters of the Find-Edge-Tool in the pop up dialog box.

Findedge Setting Dialag @
Parameter
Predsion D 1.60 Size of edge points
M 50 o, 360
Raw Size U 10,00 100
_ " -
Threshold U 0.80
Edge Power D 30 Default
More Settings =

178



Chapter 11 The probe measurement function

The software probe measurement function is powerful. It can measure the
two-dimensional and three-dimensional element features, such as the height, plane,
cylinder, cone, ball, and ring. It supports 7 methods to build the three-dimensional
coordinate system, and also support the synchronization of the image measurement
and the probe measurement. The probe measurement program can be run like the
CMM software program, and its programming is more convenient. The probe function
button is in the measurement method toolbar, as shown below:

,:'_) 321
— Plane-Plane-Planea
+ Plane-Line-Line
— r Plane-Line-Circle
¥ Y '.
@ g ‘ "'\ ‘ J’)/ ‘ G-:l ‘ + ‘ I'\_\) T ‘ ﬂ ‘ - Plane-Circle-Circle
= } Cylinder-Paint-Line
[+ 0
\ }—' N Cylinder-Point-Circle
L | to ) - [a
o P a

The probe measurement method button
Methods of building coordinate

system with probe
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If the probe button is not on the measurement method toolbar, you can select the
"System settings->Function Hidden" in the main menu, and check the "probe" option

as shown below:

File(F} Preset(P) CS[C} User Program(P} Image(

&5 {1 {0]{0{¢F ]

Lo B

System Settings(S) | Tools(B) Help(H)

Language )n‘ % = (:_’r
Basic Parameter(B)
Default Probe Count(F)

Cutput Display(5)
User Program(U}

Function Hidden(H}

Element List Window(E}

CAD Settings

User Prefrence
Compensation|C) »
Safe Height...

Laser Synchronization...[L}
Hardware Settings...[D)

Probe Management...[F}

Probe Synchronization...[C]
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1. Probe calibration

The probe system must be calibrated before using it, you can use the standard block

gauge, standard sphere, or standard ring to calibrate the probe system.
Step 1: Select the "System settings>probe management” in the main menu, pop up

the Probe System Management dialog box, as shown bellow:

FilefF]  PresetfF] S0  User Program(P]  Imagef

415 {-1]0{8{r ]!

E

g

Each grid point of the schematic diagram represents a different angle state of the
probe. You can click on the corresponding grid point to calibrate it according to the
current angle state of the probe. If the probe angle can not be changed, you only need

to click the grid point(0,0) to calibrate the probe system.



If the probe system is changed, for example, the probe body or the stylus is replaced,
or the angle of the probe system is changed, in these cases you should recalibrate the
probe system, or you can click the triangle symbol on the top left corner of the dialog

n

box, and select the “"add new system...” option to create a new probe system and

calibrate it. You can also check the “star type"” option to calibrate the star probe
system. As shown below: The different grid points correspond to the different angel
state of the probe system.

| ProbeSystem Manager @

ersi(OEFAULD)
) : 40— T angle (0,0) angle(0,45) angle(0,90)

angle(0,0)

angle(0,45)

T angle(090)

D& Toler

I"| Star type 2000 -1.000
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Step 2: Click the left mouse button on a grid point, for example, clicking the grid

point(0,0) to calibrate the simple probe system, and select the calibration
standard in the pop-up calibration dialog box.

BrobeSystem Manager

SysL{DEFALLT}

Calibrate -- A=0.0, B=0.0

Probe daimeter:0.0000

Probe tolerance:0.0000

a To r
[ 5tar type ki

The simple probe

The software supports 3 kinds of calibration standards: the standard block, sphere,
and ring. The probe calibration operations with them are discribed as follows:
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(1) Calibrating with the standard block:

When the calibration standard is a block, enter the actual length value of the
block, and take at least 4 hits on one suface of the block, and take one hit on the

opposite surface, click the Finish button to complete the calibration, and then click the
OK button to exit the dialog box.

Calibrate -- A=0.0, B=0.0

| Block - | Length: 100

:

Probe daimeter:0.0000

Probe tolerance:0.0000
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(2) Calibrating with the standard sphere:

When the calibration standard is a sphere, enter the actual diameter value of the
sphere ,and take 5 hits on the suface of the sphere according to the positions of the

following figure, click the Finish button to complete the calibration, and then click the
OK button to exit the dialog box.

Calibrate -- A=0.0, B=0.0

|Sphere - | Daimeter: 25

SPHERE

5

Probe daimeter:0.0000

Probe tolerance:0.0000
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(3) Calibrating with the standard ring:

When the calibration standard is a ring, enter the actual diameter value of the ring,
and take 4 hits on the standard suface of the ring according to the positions of
following figure, click the Finish button to complete the calibration, and then click the
OK button to exit the dialog box.

Calibrate -- A=0.0, B=0.0

[Rjng v] Daimeter: 40|

k

Probe daimeter:0,0000

Probe tolerance:0.0000
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2. Probe measurement steps
The following takes measuring the cylinder as an example to describes the probe

measurement steps:
Step 1: Click the "Cylinder" element button and the "Probe" method button, pop-up

cylinder probe measurement dialog box.

- | /|®|F |o|0o|0|&|8
Definitions: A O vEP L
Approach distance : QS v R+ Ol ]|
The probe movement distance of approaching =

slowly to the measuring point before it takes a hit
Seach distance :
The seach range near the measuring point.

Back distance :
The probe movement distance returning from

t h e m e a S U ri n g pO i n t . Approach Distance:  Search Distance: Back Distance:

30  v|mm 30  v|mm 30 ~|mm
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Step 2: Set the measuring points number of the cylinder to 6, you can also click the
Upper or lower triangle symbol to increase or reduce the number. Take 3 measuring
points as an example. You must set the Goto points if the probe movement may cause
a collision. As shown below, the probe move from the start point. The red points are
measuring points, and the green points are Goto points, The arrow direction
represents the direction of the probe movement trajectory. Take a hit at the position
of the measuring point ,and click the "Add " button "'EIE to add the Goto point at the
position of the green points, the software will record all these points. And then get the
other 3 measuring points by the same method discrabed above. and you can also click

the “delete” button to delete the unsatisfactory points

Goto point Tes®
Measuring point ?f. K
Starting Goto point &
®..... o
y"— S~



Step 3: It will automatically display the "cylinder" element in the element list area
when the point collection is complete, click the run button to automatically

measure the cylinder with the probe

I;l »&

|:| Show Elements Only Over Tolerence

3. Synchronization of the probe and the image

The synchronization of the probe and image means that the measurement results
should be the same whether you measure the same element with the probe or with

the Optical imaging system. You can decide whether or not to synchronize according

to actual needs.
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For the synchronization of the probe and image, you need to measure the same
circle and the same plane with the Optical imaging system and the probe. The
following introduces the synchronization steps by measuring the same standard

cylinder diameter and the same plane on the cylinder.
Step 1: Measure the "image circle". Click the “Circle” element button and

“Subsection” method button, focus the top plane of the standard cylinder,
and extract the circle element with the optical imaging system.

- | /]|6]7 |e|Oo|o|o|4| 8| | =

818 |~VP & ! E

e[S ? = | :

© -

+/OPOD ___________ 'g

‘.‘NQ? =
@@

S Model mm oo CARTESLAM
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Step 2: Measure the "Probe circle". Click the “Circle” element button and the

“Probe” method button, measure the cylindrical surface with the probe

- | /|@]7 |®|O|o|0|4(8
A8 VP
O|O|" ¥ R +|1]™ WO
Goto point
CIR &= Measuring point ;f. <
Starting Goto point &

Praojection Plane

| Auto |

Approach Distance:  Search Distance: Back Distance:

30 ~|mm 30 ~+|m  [30 ~|mm
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Step 3: Measure the "Probe plane”. Click the “Plane” element button and the

“Probe” method button, measure the cylinder top plane with the probe.

- | /|®|F |®|O|lo 01248
NN
o|o|~|yv|]|+[Y] & e

PLN
5 Rty
% X ¥ %

Approach Distance:  Search Distance: Back Distance:

-y,
~

-
” -

—

30 v|mm 30 v|mm [30  ~|mm
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Step 4: Measure the "Focus plane”. Click the "Focus plane” button and the
“Boundary” method button. Measure the cylinder top plane with the auto
focusing method (Note: This step can be omitted when there is no chamfer on
the edge of the standard cylinder, that is the plane of the “image circle” is the
top plane of the cylinder.)

Extracting points with Constructing the focus plane with
autofocus method all the points have been measured
./@@@ED@E—;@‘ Lens +/O|C|u3n|a’£‘.°“.|‘|
A O VP - ~n| P
Bl&|" ¥ R +]| = RO M~
PlIL]| ¥ 1!) El
() CIF 1k
(DO 2 24
- PLN1 PLN1 A
P FPHA 44
&2 FPN2 sk
H#HFPN3 FPN3 6

£ Frne FPN4 b
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Step 5: Select the "System Settings—>Pobe synchronization” in the main menu, pop

-pup the synchronization dialog box.

File(F)
A -

Preset(P}] CS(C User Program(F}

A, -

—

T -

® -

® -

Image(l)

f’.

q

System Settings(S} | Tools(B)
Language

Basic Parameter(B}
Default Probe Count(F}
Qutput Display(s)

User Program{L]}
Function Hidden(H]}
Element List Window(E}
CAD Settings

User Prefrence
Compensation|C)

Safe Height...

Laser Synchronization...[L)
Hardware Settings...[D]
Probe Management...(F)

»

Help(H}

G_LE

Probe Synchronization...[C)
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Step 6: Select the corresponding circle and plane have been extracted in the dialog
box, click the "Synchro" button to complete the synchronization. If you know the
offset values between the optical imaging system center to the stylus center, you can
also enter the offset values and click the OK button to complete the synchronization.

' X7
. This option can not be

Image Crck: | CIR1 ’] selected when step 4 is image Crde:| d
Probe Circle:| CIR2 ;/ Omitted Probe Circle:| v|
Focus Plane:| REC2 (optional) Focus Plane:| v| (optional)
Probe Plane:| REC1 v| Probe Plane:| v|

Offset Xz Offset Xz 20.525

Offset Y: Offset ¥: 15.243

Offset Z: Dffset Z: 12.024

o]
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Chapter 12 Other parameter settings
1. Language switching

Select the "System settings=> Language” in the main menu, you can select one of
the languages of the software interface, the software supports 4 languages: Simplified
Chinese, Traditional Chinese, English, and Korean.

FilefF] Preset{P} CS(C) UserProgram(F] Imagefl] | System Settings(S) | Tools(B] Help(H)

&'S'H'I'G)'@'f’"' Language M e 3
— Basic Parameter(B) ey =
Default Probe Count(F) _English
Cutput Display(s) =20

User Program{L]}

Fundtion Hidden(H)

Element List Window(E}

CAD Settings

User Prefrence
Compensation|C) »
Safe Height...

Laser Synchronization...(L)
Hardware Settings...[D)

Probe Management...[F)

Probe Synchronization...[C]
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2. User prefrence settings
Select the " System settings—> User prefrence" in the main menu, you can set Partial

functions according to your prefrence. Instructions are as follows

User Prefrence Settings ==
FilelF) Preset(F) CS(C) User Program(P) Imagef) | System Settings(S) | Tools(B] Help(t Curve Trace Settings
_ Language » [ RealTima Ediipse 1 Pixel
R R Ik E R [OR [OR Fati Ik : j
— Basic Parameter(B) E [Elrretrace first
Default Probe Count
& Foot switch
Output Display(s) . el = 1
' Do nothing " Probe pont. || Run/Pause user progra

User Program(L)
Function Hidden(H])
Element List Window(E)

Default construction method

[ZIpopup selection dizlog while construction,

CAD Settings Preel caloration

User Prefrence [@lusing four crdes ™ Usng one croie

Compensation|C) 3 -
Safe Height... [ o

Curve trace settings : This option is used for extracting the open curve and the close
curve by contour scan method(See chater 6(9)). If you check the “Real-Time” option,
the software will automatically caculate the points number and generate the curve
with these points, otherwise you should enter the points number if you check
the “pretrace first” option
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Foot switch : Set the action when the foot switch is depressed.
Default construction method : Choose to construct the element by the default

method, or by selecting the method in the construction method dialog box.
Pixel calibration type : Choose to use the 4 circles pixel calibration or the one circle

pixel calibration
3. Cross lines settings

Select the "image—>Cross settings” in the main menu, you can set the parameters
of the cross lines in the cross set dialog box

’Eluss Set Dialog |
) . Cross Line Set
FilefF} Preset(F] CS{C) User Program(F} | Image(l] | System Settings(5) Tools(B] Hel P s _3 c:r-::;szr
& J ,\’ i - I d ® J ® J Pixel Calibration }__| e — | )
shaw Cross LreStyle: ——— ~ touss Sel Center
Cross Settings
v | show Scale demsiontiae
. Show hegistant e [ show Ringls)
Show Grid Arge: o Acd Diameter: o add |
Grid Settings I 1
NO: angee | e Cizmeter |
Zl Show Dimension
ZI Show Element
Show Element(s) Unmeasured{U) | |
D Dl al; Jelete Deiete A1
Element Dimension Settings
o . Oefmit | [ ok
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4. Output display settings
Select the "System Settings>Output Display” in the main menu, you can set to

display which item of the elements in the result display area by default, and whether
to output one of these items by default.

butpul Setting =
_ ~spine | wtDismnce | A aade | O st
@ Ring | ‘@ flpse | O Rectangle i ™ Arc
| Ocide | # e | ® pont | R Foos?ane
® Ciirder | & cone | @ sphere | @ pne |
File{F) Preset{F] C5{C] UserProgram(F} Image(l} | System Settings(5) | Tools(B) Help(H ——
Language 4 [@] Center %
é:v"\’vHvIv@v@v - »] =
ga — Basic Parameter{B) - L Center¥
[@] center Z Title
Default Probe Count(F) T AssL
Output Display(s) 7] Axis M Messure
[¥] Axs [
User Program{U} I‘""I i ¥ Haminal
(9] Heght [¥] over
Function Hidden(H] 7] Diameter T
- ¥ Up
CAD Settings W7 ] Low
[&] T e
User Prefrence '-;_ [¥]5tate
M7 !
Compensition|C) 4 || Ponts
Hardware Settings...[D)
Probe Management...[F}
Probe Synchronization...[C]

[¥] S=t Default Output

(" Apply to selected () Apoly to allelements @ Apply to nore

Seect All H Reverse H Ok J| Cancel || Aoply
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5. Basic parameters settings

Select the "system settings—>basic parameters” in the main menu, you can set the
coordinate type, unit, angle type, and the number of decimal the places in the “units
setting” dialog box. You can also double-click the corresponding position of the

software status bar to set the first three parameters.

Units setting

FilelF} Preset(F} CS(C) User Program(P) Image(d WF
&./\,.H.I.G).@.(f’.n’ Lan?uage » X'Y R,e

Easic Parameter(B) -

Default Probe Count(P}

Output Display(s) mm inch Hm mil

User Program(U} BT Jidiins] [ i) it 3l

Function Hidden{H)

SBEELEE d.d rad  dms

User Prefrence A i i

Compensition(C) 3

Hardware Settings...[D]

Probe Management...[P) Decimals

Probe Synchronization...[C) 3—7 J OK

Note: Please do not arbitrarily set other parameters are not introduced, just keep
them by default.
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